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FOREWORD
This report contains all the work done and the experience gained during my two months of industrial programmed which I had at Marindoty Computer and Educational Institute in ikirun Osun State and it is written in chapters according to how the training goes.
The five chapters report is arranged as follow. Chapter one unveils a brief background of the advent of SIWES programmed into Nigeria tertiary institution academic calendar. Chapter two reveals the major sections and units in the host organization and student’s specific involvement in the organization during training. Chapter four elucidates on work done by the intern in the organization, the relevance of the experience gained as it is in-line with the kernel of Computer Science.
The last chapter of the report elucidates on conclusion, recommendation and suggestion for institution and organization.
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CHAPTER ONE
1.0 INTRODUCTION
This chapter gives a brief history of SIWES, its aims and objectives, as well as a short narrative on my application and posting. It also introduces intelligent solution providers (ISP) of Computer, where I had my SIWES training.
1.1 ABOUT STUDENTS INDUSTRIAL WORK EXPERIENCE SCHEME
The student work experience scheme (SIWES) is a worldwide program practiced in countries like Japan, Australia, USA, Europe, and in African countries too. It is popularly known as co-operative education and referred to as sandwich in Europe. It is a six (6) months students industrial work experience scheme (SIWES) taken in the third year of the degree program, where the students go to various establishments related to their course of study.
The program was initially introduced in Nigeria by the Industrial Training Fund (I.T.F.) which was established under Decree 47 of 1972 by the Supreme Military Council, headed by General Yakubu Gowon. The Decree was billed to take effect from 31st March, 1974 and had as its core objective, the gradual reduction of the percentage of foreign participation in most of Nigeria’s economic activities, accompanied by a systematic cooperation of locally oriented skilled manpower into the vast economic sector.
One of the key functions of the ITF is to work as cooperative body with industry and commerce where students in institutions of higher learning can undertake mid-career work experience attachment in industries which are compatible with student’s area of study. The students Industrial Work Experience Scheme (SIWES) is a skill Training program designed to expose and prepare students for the Industrial work situation which they are likely to meet after graduation. Participation in SIWES has become a necessary pre-condition for the award of diploma and degree certificate in specific disciplines in most institutions of higher learning in the country in accordance with the education policy of government.
1.2	BRIEF HISTORY OF SIWES
The word SIWES (Student Industrial Work Experience Scheme) was introduce by the federal government in the year 1973 to develop the technological, physical and social skill of our nation, through this, adequate and intelligent student are provide the department involved the actual challenge various discipline before they can be awarded as am National Diploma (ND) graduate.
The Student Industrial Work Experience Scheme (SIWES) in Nigeria has its roots in the Industrial Training Fund (ITF) Act of 1971. This act established the ITF with the primary objective of promoting and encouraging the acquisition of skills in industry and commerce to facilitate industrial development in Nigeria.
SIWES, formally launched in 1973, was designed to bridge the gap between theoretical knowledge acquired in the classroom and practical skills required in the workplace. It mandates tertiary institutions in Nigeria to incorporate a period of practical training into their curriculum, typically lasting between three to six months, depending on the program of study.
The program initially focused on disciplines such as engineering, technology, and science-related fields but has since expanded to encompass a wide range of disciplines, including social sciences, humanities, and the arts.
Over the years, SIWES has evolved to become a vital component of Nigeria's educational system, providing students with hands-on experience in various industries and organizations. It aims to expose students to real-world work environments, foster the development of technical and professional skills, and enhance their employability upon graduation.
SIWES has also contributed to strengthening the collaboration between academia and industry, fostering partnerships that promote knowledge exchange, innovation, and economic development. Through the program, students have the opportunity to apply theoretical concepts in practical settings, gain insights into industry practices, and develop valuable networks within their chosen fields.
Despite facing challenges such as inadequate funding, insufficient placement opportunities, and administrative bottlenecks, SIWES remains a critical component of Nigeria's efforts to bridge the skills gap and build a competent workforce capable of driving industrial growth and innovation in the country.
Top of Form
1.3 AIMS AND OBJECTIVES OF SIWES
1. Provide an avenue for students in institutions of higher learning to acquire industrial skills and experience in their approved course of study and also by interacting with people with more experience in the field under consideration.
1. Prepare students for the industrial work situation which they are likely to meet after graduation.
1. Expose students to work methods and techniques in handling equipment and machinery that are mostly not available in their various institutions.
1. Provide students with an opportunity to apply their knowledge in real world situation thereby reducing the gap between theoretical knowledge and practical work.
1. Enlist and strengthen employers’ involvement in the entire educational process and prepare students for employment in Industry and Commerce.
1.4 ROLES OF STUDENT
1. Attend SIWES orientation programme before going on attachment.
1. Comply with the establishment’s rule and regulation.
1. Arrange living accommodation during the period of attachment.
1. Record all training activity done and other assignment in the log book.
1. Complete SPEI from ITF, FORM 8 and get it endorsed by the employer for submission to the ITF.
1.5 OBJECTIVES OF THE REPORT 
The objectives of the SIWES report are;
1. To make through explanation of the work done during my four month industrial training.
1. To fulfill the requirement for national diploma in computer science.
1. To contribute to the body of knowledge and to enhance the understanding of the writer about a similar or same job.


1.6   THE LOGBOOK
The logbook issued to student on attachment by the institution was used to record all daily activities that took place during the period of attachment, and  it was  checked  and endorse by the industry based/institution based supervisors and ITF during supervision.
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2.1   BRIEF HISTORY OF MARINDOTY COMPUTER AND EDUCATIONAL INSTITUTE
Marindoty Computer and Educational Institute was established to provide quality education in computer technology and other academic disciplines. It began as a small training center, offering basic computer literacy programs to students and professionals seeking to improve their digital skills. Recognizing the growing demand for computer education, the institute expanded its curriculum to include advanced courses in programming, networking, and information technology.
As the institution gained recognition, it broadened its academic offerings beyond computer studies. It introduced vocational and technical education programs to equip students with practical skills for the evolving job market. Over time, Marindoty Computer and Educational Institute became known for its commitment to academic excellence and hands-on training, attracting a diverse student population.
With a strong emphasis on modern teaching methodologies, the institute integrated innovative learning techniques such as online courses, interactive workshops, and industry partnerships. These efforts ensured that students received up-to-date knowledge aligned with industry standards. The school also collaborated with local and international organizations to enhance its programs and provide career opportunities for graduates.
The institute’s success led to the establishment of multiple campuses and training centers, making its educational services more accessible to a wider audience. It continuously upgraded its infrastructure, investing in state-of-the-art computer labs, libraries, and research facilities. Faculty members, consisting of experienced educators and industry experts, played a crucial role in maintaining the high quality of education.
Today, Marindoty Computer and Educational Institute remains a leader in computer and technical education, producing skilled professionals who contribute to various industries. Its mission continues to focus on empowering individuals through knowledge and innovation, ensuring that students are well-prepared for the challenges of the modern world.

CHAPTER THREE
3.0 	DESCRIPTION OF WORKDONE 
· How to Work on MS Word   
	Microsoft Word is a widely used word processing software that allows users to create, edit, format, and save documents efficiently. To start working on MS Word, open the application and choose either a blank document or a pre-designed template. The interface consists of various tabs such as "Home," "Insert," "Layout," and "Review," each offering different tools. The "Home" tab provides basic text formatting options like font style, size, bold, italics, and alignment, while the "Insert" tab allows users to add images, tables, and charts to enhance their documents.
Once the content is added, users can format the document to improve readability and presentation. MS Word offers paragraph spacing, indentation, bullet points, and numbering options. The "Design" and "Layout" tabs help in adjusting margins, page orientation, and themes to give documents a professional look. Additionally, users can utilize the "Review" tab for spelling and grammar checks, comments, and track changes, which are useful for collaborative editing.
After finalizing the document, it can be saved in various formats, including .docx, .pdf, or .txt. The "File" tab provides options to save, print, and share documents via email or cloud storage like OneDrive. MS Word also allows users to secure files with passwords and restrict editing permissions. By mastering these features, users can efficiently create high-quality documents for personal, academic, or professional use.
· How to Work on MS Excel Word 
	Microsoft Excel and Microsoft Word are essential tools for document creation and data management. MS Word is a word processing software used for typing, formatting, and editing text documents such as letters, reports, and resumes. Users can customize font styles, sizes, and colors, insert tables and images, and use built-in templates for professional document design. Additionally, MS Word provides features like spell check, grammar suggestions, and page layout tools to enhance the document’s presentation.
	On the other hand, MS Excel is a spreadsheet application used for data organization, calculations, and analysis. It allows users to create tables, input numerical data, and apply formulas to automate calculations. Excel’s built-in functions, such as SUM, AVERAGE, and VLOOKUP, help process large datasets efficiently. Users can also generate charts and graphs to visualize trends and patterns. The software’s conditional formatting and filtering options make it easy to highlight important data and organize information effectively.
	To work efficiently with both programs, users should familiarize themselves with essential shortcuts, tools, and features. In MS Word, learning how to use headers, footers, and formatting tools can improve document readability. In MS Excel, mastering formulas, pivot tables, and data validation enhances productivity. Both applications support collaboration, allowing multiple users to edit and share documents in real-time via cloud services like OneDrive. By understanding these tools, individuals can streamline their work and improve efficiency in various tasks.
· How to Work on Power point
	PowerPoint is a popular presentation software used to create slideshows for business, education, and personal projects. To start working on PowerPoint, open the application and choose a blank presentation or a template. The main interface consists of slides where you can add text, images, charts, and multimedia elements. The toolbar at the top provides various options for formatting text, inserting shapes, and designing slides. Users can navigate through slides on the left panel and arrange them as needed to structure their presentation effectively.
	To enhance a presentation, PowerPoint offers design and animation tools. You can apply themes and templates to maintain a professional look. Transitions help move smoothly from one slide to another, while animations bring text and images to life. The software also includes features like SmartArt, charts, and tables to present data visually. By clicking on the "Slide Show" tab, users can preview how their presentation will appear when presented.
	Once the presentation is complete, PowerPoint allows users to save and share their work in different formats, such as PPTX, PDF, or video. You can rehearse your presentation using the "Rehearse Timings" feature to improve delivery. When presenting, PowerPoint offers tools like laser pointers, slide notes, and presenter view to assist in delivering a smooth and engaging presentation. Whether for business meetings, academic lectures, or personal projects, PowerPoint provides a versatile platform for creating and delivering impactful presentations.
· Introduction to Function Button on Photocopy 
	A photocopy machine is an essential device used in offices, schools, and businesses for duplicating documents. It has various function buttons that control its operations, allowing users to customize copies based on their needs. Understanding these buttons ensures efficient use of the machine and prevents errors during copying tasks.
	Key function buttons on a photocopier include the Start Button, which initiates the copying process, and the Stop/Cancel Button, which halts an ongoing task. The Number Pad allows users to enter the desired number of copies, while the Paper Size Selector lets them choose different paper dimensions. Additionally, the Zoom/Enlarge-Reduce Button enables users to resize documents according to their preferences.
	Other important buttons include the Duplex (Double-Sided) Button, which allows double-sided copying, and the Tray Selection Button, which selects the paper source. Some modern photocopiers also feature Touchscreen Panels for advanced settings such as color copying, image adjustment, and document finishing options like stapling or hole-punching. By mastering these function buttons, users can efficiently operate a photocopier and enhance productivity in document reproduction.
· How to Scan Documents
	Scanning documents is a simple process that allows you to create a digital copy of a physical document using a scanner or a multifunction printer. To begin, turn on the scanner and place the document face down on the scanner glass or into the automatic document feeder (ADF) if multiple pages need to be scanned. Ensure that the document is properly aligned to avoid cropping or skewed images.
	Next, select the scanning settings using the control panel on the scanner or a connected computer. You can choose the scan format (such as PDF, JPEG, or PNG), resolution (DPI), and color mode (black & white or color). If using a computer, open scanning software like Windows Fax and Scan, Adobe Acrobat, or the scanner’s built-in program. Then, press the Scan button on the machine or the software to start the scanning process.
	Once the scan is complete, the document will be saved to the selected folder or displayed on your computer screen for preview. You can edit, rename, or share the scanned file as needed. If additional pages need to be scanned, repeat the process. Scanning documents helps in digital storage, email sharing, and creating backup copies for important files.



 



CHAPTER FOUR
4.0	RELEVANCE OF THE EXPERIENCE GAINED BY STUDENT DURING THE PROGRAMME
During my SIWES (Student Industrial Work Experience Scheme) placement at Marindoty Computer and Educational Institute, I was exposed to an enriching experience that significantly enhanced my academic knowledge, practical skills, and overall professional development. The institute, known for its dedication to quality training in computer applications and educational services, provided me with an ideal environment to bridge the gap between classroom learning and real-world applications.
One of the first things I noticed upon resuming at the institute was the structured and organized nature of its operations. I was introduced to the different departments and their functions. I spent the initial days familiarizing myself with the system and understanding the workflow. This foundation proved essential as it gave me a sense of direction and purpose throughout the training.
The technical skills I acquired during my time at the institute were immense. I was trained in various computer applications, including Microsoft Office Suite, CorelDRAW, and basic programming with Python. Although I had some theoretical background knowledge, applying these tools in a practical setting helped solidify my understanding. I worked on tasks like data entry, typing, formatting documents, designing flyers and posters, and assisting students with assignments and computer-based tasks. This constant exposure improved my speed, accuracy, and confidence in handling such tools, which are crucial in any professional setting.
One particular highlight was my involvement in the ICT training classes the institute conducted for students of different educational backgrounds. I assisted in preparing the teaching materials, organizing sessions, and sometimes helping to facilitate classes. This responsibility taught me the importance of effective communication and the ability to break down complex information into simpler terms. I developed a deeper appreciation for teaching and the patience it demands, especially when dealing with beginners who had little to no prior experience with computers.
Working under the supervision of experienced instructors and administrative staff offered me insights into workplace ethics and professional conduct. I learned the importance of punctuality, respect, teamwork, and taking initiative. These values are often discussed in theory, but it was in the day-to-day routines and interactions that I came to appreciate their true significance. I observed how problems were approached systematically, how clients were attended to respectfully, and how team members supported one another to meet deadlines and expectations. These observations gradually influenced my attitude, and I found myself becoming more disciplined, responsible, and proactive.
Administrative tasks were another area in which I gained considerable experience. I participated in student registration processes, helped maintain attendance records, and contributed to the organization of training schedules. These activities introduced me to basic record-keeping techniques and the importance of maintaining accurate data. I also learned to use tools like Excel for managing spreadsheets and tracking progress, which was both satisfying and empowering. Understanding how these tools support decision-making and planning in a real organization helped me grasp their importance beyond the classroom.
During my SIWES, I was occasionally involved in minor technical troubleshooting, such as setting up computer systems, connecting peripherals like printers and projectors, and resolving basic hardware or software issues. Though these tasks seemed small, they were essential for the smooth operation of the training center. Solving such issues not only built my technical confidence but also instilled a problem-solving mindset. I learned that being calm, observant, and logical were key to diagnosing and fixing issues efficiently.
The experience also showed me how crucial it is to be adaptable. There were times when I had to step out of my comfort zone, such as covering for absent staff, learning new software on short notice, or handling tasks I had not been formally trained for. These situations taught me to be flexible and to view challenges as opportunities to grow. I developed a more positive attitude toward change and uncertainty, which I believe is an essential quality in today’s ever-evolving work environment.
As the weeks went by, I noticed a transformation not just in my skills but in my confidence. Tasks that initially seemed overwhelming became manageable, and I began to take pride in contributing meaningfully to the team. The feedback I received from supervisors was constructive and encouraging, and I felt a genuine sense of accomplishment each time I successfully completed a task or helped someone understand a concept better.
My SIWES at Marindoty Computer and Educational Institute was a deeply rewarding and transformative experience. It helped me translate theoretical knowledge into practical expertise, enhanced my technical and administrative capabilities, and prepared me for the realities of the professional world. I left the institute with a stronger work ethic, improved communication skills, and a clearer sense of direction for my future career. The experience not only added value to my academic journey but also shaped my personal growth in ways I had not anticipated.
 CHALLENGES ENCOUNTERED
1.	Financial scar
2.	Starkness of industrial staff
3.	Proximity of industrial location
4.	Limited internship period



CHAPTER FIVE
5.0	CONCLUSION
The SIWES program expected to be undergone by all students in the school of applied science in all tertiary institution in Nigeria.
I therefore deeply appreciate the industrial training of my school (Kwara State Polytechnic, Ilorin) for involving themselves in such a worldwide program. The importance of this training cannot be over emphasized industrial training by some operations carried out during the program.
5.1   RECOMMENDATION
I like to use this medium to explore the federal Government at all stage to take this SIWES program more seriously seen by the students of applied science as a virtual improvement in future of  technology in our nature.
Government should also ensure a proper supervision of SIWES student so that the purpose of the programme will be achieved.
The federal Government should make adequate provision in the annual budget for proper funding of SIWES in view of the potential of the scheme to contribute to enhancing the quality of the pool to technical skill available to the economy.
A comprehensive and detail directory of employer who accept students for SIWES is urgently required to facilitate placement of student in industry.
In order to guarantee quality assurance of institution and the ITF. The ITF should ensure that the backlog in payment of students allowance is cleared urgently to remove the negative image being created for SIWES.
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